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License Agreement

You should carefully read the following terms and conditions before using this software. If you do
not agree with these terms, return the package within 10 days of purchase, together with proof of
purchase, and your money will be refunded.

This package includes one or more diskette(s) and/or CD-ROM(s) containing copies of computer
software programs, all or part of which are owned by Agfa-Gevaert N.V. (“AGFA”). These media
may also contain complete software programs, all or part of which are owned by other parties (“the
Other Owners”). This package also contains documentation relating to these software programs. In
this Agreement, the term “Programs” refers both to the software programs and the related
documentation. AGFA and the Other Owners retain ownership of the Programs and the other
contents of this package. You, and any other person acquiring the Programs pursuant to paragraph
7 (b) below, are licensed to use the Programs on the terms and conditions outlined below.

Limited Use License

1. You are granted a non-exclusive license (“the License”) to use the Programs only on the terms
and conditions set in this Agreement.

2. The Programs may be used only by you.

3. You agree to use the Programs solely for your own customary business or personal purposes.

4. (a) You and your employees and agents will protect the confidentiality of the Programs.

(b) Except as provided in paragraph 7 (b) below, you will not sub-license, sell, lease, rent,
distribute, disclose or otherwise make the Programs available to any other person.

5. (a) Other than for normal use of the Programs, or to make one back-up copy of the Programs in
machine readable form, you may not copy or reproduce the Programs, in whole or in part, for
any purpose.

(b) The Programs contain certain copyright notices. You must include all such copyright
notices on any copy or reproduction you make. Further, you must acknowledge that any such
copy or reproduction will be owned by AGFA and, if applicable, the Other Owners.

6. You may not alter, modify, or adapt the Programs. You may not merge all or any part of them
into any other computer software programs. You may not translate, decompile or disassemble
the programs or, without prior written permission of AGFA, create any computer software
programs or other words derived from the Programs.
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7. (a) You may not sub-license, assign or transfer this License to any other person, either in whole
or in part, other than as provided in 7 (b) below.

(b) You may transfer your rights under the License to another person provided that, at the time
of transfer:

(i) You pass the Programs (and all copies in your control) to the person acquiring your rights
under the License.

(ii) The person acquiring your rights signs and returns to AGFA a Registration Card (thereby
agreeing to be bound by the terms and conditions in the License). Registration Cards are
available from AGFA upon request. Following such a transfer, all your rights under the License
will pass to the person acquiring the Programs.

8. If you violate any of the above conditions, this License will be automatically terminated.

Term

The License is effective until terminated. You may terminate it at any time by notifying AGFA in
writing. The License may also terminate in accordance with conditions set out elsewhere in this
Agreement. You agree that upon any termination, you will immediately destroy the Programs
together with all copies, and will immediately notify AGFA in writing.

Limited Warranty and Liability

1. If you discover any physical defect on the Program media, and return the media to AGFA within
90 days after purchase, together with proof of purchase, AGFA will replace the media at no
charge to you.

2. Although AGFA has tested the Programs and reviewed the documentation, AGFA does not
warrant that the Programs will meet your requirements, that they will function in every
hardware/software environment, or that their operation will be uninterrupted or error free.

3. Except for the above express limited warranties, AGFA and the Other Owners give no
warranties, guarantees or conditions whether express or implied, by statute or otherwise, in
relation to the Programs, their quality, description, or fitness for any particular purpose.

4. Since some countries do not allow the exclusion of implied warranties, the above exclusion may
not apply to you. This warranty gives you specific legal rights. You may also have other rights.

5. In no event whatsoever shall AGFA, and the Other Owners, have liability for any special,
indirect or consequential losses of profit or otherwise, or for losses of recorded data, in relation
to the use or any inability to use the Programs.

6. Since some countries do not allow the limitation or exclusion of liability for incidental or
consequential damages, the above limitation may not apply to you.

7. No distributor, dealer or agent of AGFA is authorized to make any modification or addition to
this statement of limited warranty and liability.
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General

1. Should you have any questions about this Agreement you may contact Product Management
GS/EPP by writing to:

2. Agfa-Gevaert N.V. at Septestraat 27, B-2640 Mortsel, Belgium.

3. This Agreement is governed by the laws of the country in which it was purchased.

4. If the Programs are used within a country of the European Community, nothing in this
Agreement shall be construed as restricting any rights available under the European
Community Software Directive, O. J. Eur. Comm (No. L. 122) 42 (1991).

5. If any provision of this Agreement is held invalid, the remainder of this Agreement shall
continue in full force and effect.

You acknowledge that you have read this Agreement, understand all of its provisions and agree to
comply fully with them. You further agree that this Agreement contains the complete and exclusive
statement of the agreement between you and AGFA in relation to the Programs, and that it
supersedes any proposal or prior agreement, oral or written, and any other communications relating
to the subject matter of this Agreement.



About This Guide 6

About This Guide

Purpose
This manual describes how to launch and use Agfa Raster Preview. Raster Preview runs on a
PowerMac or Windows® NT™/Windows 98 platform, and allows you to examine the rasterized job
data which is output by the Apogee PDF RIP. On the basis of this detailed job “preview”, you can
then decide to send the job directly to the imagesetter, or to abort the job. You can also save the
ripped job data onto disk using the Agfa Job Backup utility.

Intended Audience
This document is designed for users who have already installed the Apogee PDF RIP software, as
described in the relevant Apogee PDF RIP user documentation. As a user, it is assumed that you
are already familiar with your front-end workstations, imagesetter, and PostScript software
applications, as well as prepress processing methods, printing procedures, and network traffic. If
this is not the case, please refer to the relevant user or operator manuals.

� Note: All of the screen illustrations provided in this Guide are taken from a Macintosh platform.
Although the Preview Pilot has exactly the same functionality in both Macintosh and Windows
environments, you should however make allowances for some small differences in the use and
appearance of the Windows-based user interface.

Scope and Structure
Click one of the following chapter titles to jump to the chapter:
Chapter 1: Introduction

Introduces Agfa Raster Preview, and describes its main features and functions.
Chapter 2: Using Preview

Explains how to start Preview, how to set preferences, and how to use the Preview options and
tools.

More information on the PostScript Environment can be found in the "Apogee PS Companion On-
Line User's Guide", which is provided on the Apogee PDF RIP CD.
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How to Use This On-Line Guide
Use the following procedures to navigate through this guide:

Topic Click on blue text to go to the topic indicated. Underlined text indicates text that is
“linked” to another part of this guide. For example, see Chapter 1: Introduction for an
introduction to the Agfa RIP Pilot.

Click on the Go Back button in the tool bar to return to your previous location.

Click on the Next Page button in the tool bar to go to the next page of the guide.

Click on the First Page button in the tool bar to return to the opening screen of this
guide.

Click on the bookmark name to go to the topic marked by that bookmark. Click the
triangle (Mac) or plus/minus sign (PC) to the left of a bookmark to show and hide
subordinate bookmarks. The bookmarks for this guide provide a complete list of topics.

� Note: Due to rescaling, some of the screen shots included in this document may appear
unclear when displayed at 100% magnification. You can view these screen shots more clearly
by using the Zoom tool to increase the default magnification.

Related Documentation
The following documents are mentioned in this manual, and should be referred to for further
information.

� Agfa PDF RIP for Windows User’s Guide

� Agfa RIP Pilot User’s Guide

� Agfa Job Backup User’s Guide

� Apogee PS Companion User's Guide

Worldwide Web
The following website provides support for the Agfa Electronic PrePress products and other Agfa
products.

� http://support.agfa.com

http://support.agfa.com/


Contents 8

Contents

About This Guide.............................................................................................................................. 6

Purpose...................................................................................................................................... 6

Intended Audience .................................................................................................................... 6

Scope and Structure ................................................................................................................. 6

How to Use This On-Line Guide .............................................................................................. 7

Related Documentation ............................................................................................................ 7

Worldwide Web ......................................................................................................................... 7

Contents ............................................................................................................................................ 8

Chapter 1: Introduction .................................................................................................................. 11

What is Agfa Raster Preview? ............................................................................................... 12

Preview Client-Server Technology ................................................................................ 12

Raster Preview Features ........................................................................................................ 13

How Preview Works................................................................................................................ 14

Workflow Summary......................................................................................................... 15

Printing a Job “For Preview” ......................................................................................... 15

The Structure of a Job Ripped for Preview .................................................................. 16

Selecting a Job to Preview ............................................................................................. 16

Previewing Options......................................................................................................... 17

Approving /Deleting a Previewed Job ........................................................................... 18

Chapter 2: Using Preview .............................................................................................................. 19

Before You Begin .................................................................................................................... 21

System Requirements..................................................................................................... 21

Starting and Stopping the Raster Preview Server ....................................................... 22

Launching the Raster Preview Pilot...................................................................................... 23



Contents 9

Preview Main Window ............................................................................................................ 26

Preview Image Area......................................................................................................... 26

Raster Preview Pilot Menu Bar ...................................................................................... 28

Floating Tools Palette ..................................................................................................... 29

Preview Options...................................................................................................................... 30

Connecting to the Raster Preview Server / RIP............................................................ 30

Opening Pages to Preview ............................................................................................. 30

Opening Multiple Views on a Page................................................................................ 32

Closing Previewed Pages............................................................................................... 33

Image Viewing Options................................................................................................... 33

Viewing Single Color / Composite Planes .................................................................... 35

Checking Ink Coverage................................................................................................... 35

Displaying Job Information ............................................................................................ 37

Checking Screen Angles ................................................................................................ 38

Redefining Colors ........................................................................................................... 39

Showing / Hiding Rulers ................................................................................................. 40

Choosing Measurement Units........................................................................................ 40

Quitting Preview .............................................................................................................. 41

Preferences.............................................................................................................................. 41

Setting the Size of the Overview Window..................................................................... 43

Setting Attributes for the Zoomable Window ............................................................... 43

Setting Display Options.................................................................................................. 43

Setting Page Orientation Options.................................................................................. 43

RIP Connections.............................................................................................................. 44

Preview Approval Options ..................................................................................................... 45

Approving a Single Page ................................................................................................ 45



Contents 10

Approving an Entire Job................................................................................................. 47

Using Help ............................................................................................................................... 48

Preview Keyboard Shortcuts ................................................................................................. 49

Index................................................................................................................................................. 50



Chapter 1: Introduction 11

Chapter 1: Introduction

This chapter introduces Agfa Raster Preview, and highlights the main features and functions.

Click on a topic name to jump to the topic:

� What is Agfa Raster Preview?

Preview Client-Server Technology

� Raster Preview Features

� How Preview Works

Workflow Summary

Printing a Job “For Preview”

The Structure of a Job Ripped for Preview

Selecting a Job to Preview

Previewing Options

Approving /Deleting a Previewed Job
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What is Agfa Raster Preview?
Agfa Raster Preview is an integral component of Agfa’s Apogee PDF RIP. Preview allows a user to
view raster data (ripped PostScript jobs) on a remote Macintosh or Windows system. This preview
takes place after the data has been ripped, but before it has been sent to an imagesetter, allowing
the user to approve or abort the job before committing it to output.

Preview is a “read-only” application: Tools are provided for zooming and panning the image, and for
displaying various types of image information. However, no changes can be made to the raster
data. If errors are found in the previewed data, the job must be corrected in the original application,
and then re-submitted to the RIP.

Preview Client-Server Technology

The purpose of the Preview front-end program (referred to as the Raster Preview Pilot) is to
examine in detail raster data before it is sent to an imagesetter. Preview does this by reading pixel
data from the files generated by the RIP, decompressing the data, and then sending it over the
network to the client application.

Preview was designed to take advantage of client-server technology. The server application
accepts requests for data from a client application anywhere in the network and returns that data to
the client. The client then displays that data in a window with a user-specified zoom factor. Client
and server communicate using the TCP/IP protocol.

Raster Preview Server

Windows NT

Raster Preview Pilot

Raster Preview Pilot

Raster Preview Pilot

Raster Preview Pilot

Raster Preview Pilot

Macintosh or PC
Front-end

Figure 1:  Agfa Raster  Preview Cl ient -Server  Technology
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When a Preview client connects to a Preview server, they maintain a 1-to-1 connection, which
means that as long as that connection is active, no other client can connect to that server. A client
can preview only one job at a time, but can preview multiple pages belonging to the same job.

Raster Preview Server
The Raster Preview Server software runs on high-end PC’s under Microsoft Windows NT 4.0
Service Pack 3 or later.

Raster Preview Pilot
The Raster Preview Pilot (i.e., the client) is available in two versions: One for PC systems running
Windows95/98 or Windows NT, and one for Power Macintosh systems running System 8.6 or later.

� Note: Although the Raster Preview Pilot has exactly the same functionality in both Macintosh
and Windows environments, there are however some small differences in the use and
appearance of the user interface.

Raster Preview Features
The main features of Agfa Raster Preview are as follows:

� Compatibility with your Front-End System: Preview is available for both Apple Macintosh
and PC-Windows front-end workstations.

� Job Formats: Preview supports all resolutions, screening modes, and page sizes.

� Localization: International releases support six languages: English, French, German, Italian,
Spanish, and Japanese.

� Interactive User Interface: Preview features a graphical user interface which allows you to
preview single and multiple pages of a job, and multiple views of a single page. Images can be
displayed at any zoom factor from 1:128 to 32:1, and a variety of job and image data can be
viewed and analyzed.

� Multitasking: Multiple disks allow overlapping of the ripping and imaging processes; This
means that you can preview one page of a job which has been ripped, while the following page
is being ripped. Overlap between “ripping/previewing” and “imaging” is also supported, but only
on a page-by-page level.

� Optimal Performance: Through the use of “Alias Folders” and multiple physical hard disks.

� On-line Help: Preview is designed with an On-line Help system which is accessible from the
Preview main window, and which provides you with a handy on-line reference tool.
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How Preview Works
Preview allows you to examine and approve a ripped job, before committing it to an imagesetter. It
does this by creating an exact, viewable image of the data on your front-end workstation (on a scale
from 1:128 to 32:1), which you can approve for imaging, for backing up, or for deleting.

The Raster Preview server interacts with the Apogee PDF RIP to retrieve jobs which have been
requested by the Raster Preview Pilot. These jobs, which must have been explicitly printed “for
Preview” by the front-end application, can then be presented to the Raster Preview Pilot for
approval.

Apogee PDF RIP

Windows NT

("Physical" ripped data)
Disk 1 Disk 2 Disk 3 Disk 4

Job Input

Output Device

Raster Preview Server

Windows NT

Macintosh or PC
Front-end

RIP Pilot

Macintosh or PC
Front-end

Raster Preview Pilot

Macintosh or PC
Front-end

Figure 2:  How Preview Interacts  wi th  the Apogee PDF RIP
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Workflow Summary

A summary of the Preview workflow is as follows (refer to the equivalent step numbers in Figure 4):

1 Print a job “for preview” from your front-end application.

2 The Apogee PDF RIP produces raster files for preview, and stores them on multiple physical
hard drives.

3 Start the Raster Preview Pilot and select a job to preview.

4 The Raster Preview server gets the selected raster data files from disk.

5 The Raster Preview server presents the raster data to the Raster Preview Pilot (the image is
displayed in the Preview image area).

6 You can then examine the image(s) in detail, and approve the data for imaging and/or backup,
or deletion.

7 The Raster Preview server processes the raster data according to your selected approval
option.

Printing a Job “For Preview”

Any job that you want to preview must be explicitly printed “for Preview” from your front-end
application. The “Preview” option is displayed in the Print Options window when you have generated
and selected the appropriate PPD file.
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The Structure of a Job Ripped for Preview

The structure of a job which has been ripped for Preview is comparable to the structure of a multi-
level directory. The job name is the name of the 1st-level directory. This branches out into a number
of 2nd-level subdirectories which each represent one page of the job, and are identified by page
number. Each of these page subdirectories contain the actual separated raster data, and are
identified by separation name. Each separation is ripped to a separate disk if possible. This
optimizes the speed with which Preview can display a full color image, since the raster data can be
retrieved from all four disks simultaneously.

Job 1 Job 2 Job ...

Page 1 Page 2 Page 3 Page 4 Page 5

Cyan Magenta Yellow Black

Disk 1 Disk 2 Disk 3 Disk 4

Cyan

Magenta

Yellow

Black

Composite
Color Image

Separations
(Raster Data Files)

Raster Preview Server

Raster Preview Pilot

Figure 3:  The Structure of  a  Job Ripped for  Preview

Selecting a Job to Preview

Once you have printed one or more jobs “for Preview”, you can select and view individual job pages
by starting the Raster Preview Pilot, and selecting a job from the list which is automatically
displayed. You can then choose an individual page to preview. You can simultaneously view several
pages from the same job, and can examine the same page at different zoom factors.
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Previewing Options

Once a job has been selected, the Raster Preview server gets the requested raster data, and
displays it to the Raster Preview Pilot as a series of overlapping separations. The Raster Preview
Pilot provides you with a range of options for opening and previewing pages at different
magnifications, and for checking image details such as individual color separations, ink coverage,
and screen angles.

Raster Preview Server

Apogee PDF RIP

Macintosh or PC
Front-end

Raster Preview Pilot

Backup DeleteImage

Disk 1 Disk 2 Disk 3 Disk 4

RIP Pilot

Print job "for Preview"
from front-end application 

1

User (client) specifies
a job to preview

Apogee PDF RIP produces
raster files for Preview 

2

3
4

Preview server gets
raster data from
files on disk

Preview server presents
raster data to user5

User approves data
for imaging/backup or
for deletion

6Preview server processes
raster data according to
the user’s approval option

7

Windows NT Macintosh or PC
Front-end

Figure 4:  W orkf low and Post-Preview Opt ions
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Approving /Deleting a Previewed Job

When you have finished previewing the pages of a job, you have the following post-preview options:

� Approve and Image: You can approve the previewed page, or the entire job, and send it
directly to the imagesetter. Once it has been sent to the imagesetter, this page or job will be
automatically deleted, and will no longer be available for previewing or imaging.

� Approve, Image and Backup: You can approve the previewed page, send it to the
imagesetter, and keep a backup copy on disk.

� Note: For more information on backing up jobs, refer to the “Agfa Job Backup User’s
Guide”.

� Approve and Backup: You can approve the previewed page, and keep it on disk for imaging
at a later date.

� Delete: You can delete the previewed page.
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Chapter 2: Using Preview

This chapter describes how to start Preview, and how to open and view a ripped job. Information is
provided on the various Preview options and preference settings, and the different Preview approval
modes.

Click on a topic name to jump to the topic:

� Before You Begin

System Requirements

Starting and Stopping the Raster Preview Server

� Launching the Raster Preview Pilot

� Preview Main Window

Preview Image Area

Raster Preview Pilot Menu Bar

Floating Tools Palette

� Preview Options

Connecting to the Raster Preview Server / RIP

Opening Pages to Preview

Opening Multiple Views on a Page

Closing Previewed Pages

Image Viewing Options

Viewing Single Color / Composite Planes

Checking Ink Coverage

Displaying Job Information

Checking Screen Angles

Redefining Colors

Showing / Hiding Rulers

Choosing Measurement Units

Quitting Preview

.../...continued
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� Preferences

Setting the Size of the Overview Window

Setting Attributes for the Zoomable Window

Setting Display Options

Setting Page Orientation Options

RIP Connections

� Preview Approval Options

Approving a Single Page

Approving an Entire Job

� Using Help

� Preview Keyboard Shortcuts
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Before You Begin

System Requirements

The minimum supported system requirements for installing and running Preview are as follows.

Preview Pilot
� A front-end workstation, which may be either:

� A PowerMac, running System 8.6 or later, with Open Transport 2.0 or later. The system
must be equipped with at least 64 Mbytes of RAM.

� A high-end PC workstation, running Windows 98 or Windows NT 4.0 Service Pack 3 or
later. This system should be equipped with at least a Pentium processor running at
200 MHz. A Pentium III processor running at 500 MHz (or faster) is recommended. The
PC must be equipped with at least 64 Mbytes of RAM.

� Note: For both types of workstation, TCP/IP settings and addresses need to be configured.

Preview Server (Windows NT)
� Apogee PDF RIP requirements. Refer to the “Apogee PDF RIP for Windows User’s Guide”.
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Starting and Stopping the Raster Preview Server

Before launching the Raster Preview Pilot, you must first start the Raster Preview server on the
Windows NT system. The Raster Preview Server program is accessible from the Apogee PDF RIP
program group.

If the Apogee PDF RIP is installed as a "standalone" application, start the Raster Preview Server as
follows:

1 Select "Raster Preview Server" from the Start menu as follows:

2 The Raster Preview Server is now running and visible in the “system tray” on your taskbar at
the bottom right of your screen.

You can stop the Raster Preview Server as follows:

3 Right-click on the Raster Preview Server icon in the “system tray” and select ‘Exit…’ from the
shortcut menu.

4 In the confirmation dialog, click on ‘Yes’ to stop the Raster Preview Server.

For more information, refer to “Starting/Stopping the Apogee PDF RIP” in Chapter 3 of the “Apogee
PDF RIP for Windows User’s Guide”.
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Launching the Raster Preview Pilot
To launch the Raster Preview Pilot, proceed as follows:

1 Start the Raster Preview Server as described above.

2 Start the Raster Preview Pilot by double-clicking on the Preview Pilot icon:

� Note: Windows 98 & Windows NT Users: Select "Raster Preview Pilot" from the Start menu.

The Connect To Server window is automatically opened:

A list of Raster Preview Server (or RIP) host computers is displayed in the scrollbox. Any
Raster Preview Servers which are currently unavailable, or are connected to another user, are
grayed out.

� Note: Remember that when a Raster Preview Pilot connects to a Raster Preview Server, they
maintain a 1-to-1 connection. This means that as long as that connection is active, no other
client can connect to that server.

3 Select the name of the Raster Preview Server to which you want to connect, and click on the
‘Connect’ button (Mac users), or the ‘OK’ button (PC users).
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The Preview main window is displayed, and the Open dialog is automatically presented:

The Open dialog lists all of the jobs that are currently available on the selected Preview Server
(or RIP), together with the number of pages in each job.

A checkmark to the left of a job name indicates that the RIP has finished processing all pages
of the job, and all pages are ready for preview.

� Note: Jobs without a checkmark have only been partially processed by the RIP. This
means that not all pages of the job are yet available for preview.

4 Select the name of the job you want to preview, and click on the ‘Open’ button (Mac users), or
the ‘OK’ button (PC users).

A numerical list of pages within the job which are available for previewing are displayed as
follows:

5 Select the page number that you want to preview, and click on the ‘Open’ button (Mac users),
or the ‘OK’ button (PC users).



Chapter 2: Using Preview 25

The requested page is displayed:

Because of the size and detail of imaged pages, each page you open has by default two
viewing windows:

� Overview Window: Provides a snapshot of the entire page, as a low resolution continuous
tone image(see above left).

� Zoom Window: Provides a detailed raster preview of one area of the page. This view can
be panned and zoomed over the entire area of the page (see above right).

These viewing windows, together with the other elements of the Preview main window, are
described in the following section.
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Preview Main Window
The Preview main window comprises the following:

� Preview Image Area

� Preview Menu Bar

� Floating Tools Palette

Preview Image Area

The Preview Image Area is the main area of the screen in which one of more pages of a job can be
previewed. Each page you open has by default two viewing windows: an Overview window and a
Zoom window.

Overview Window
For every page that you preview, an Overview window is displayed. The Overview window displays
the entire page at a low magnification. A white “locator” rectangle in the Overview window indicates
which part of the page is enlarged in the Zoom window. You can quickly preview different areas of
the page by clicking the mouse pointer inside the locator and dragging it to another position. This
feature is only available for the currently active Zoom window.

The Overview window has two settings: small and large. You can toggle between these two settings
by clicking in the top right-hand box of the Overview window Title bar (Mac users), or in the
Preferences (PC users). You can also hide the Overview window as described in “Image Viewing
Options”.

Zoom Window
The Zoom window displays in detail the area of the image that is currently selected by the Overview
window locator.

The Title bar of the Zoom window displays the number of the page you are previewing, and the
zoom factor, as follows:

The zoom factor is always expressed in powers of 2. The available zoom factors are: 1:128 (1
screen pixel corresponds to 128 raster data pixels) - 1:64 - 1:32 - 1:16 - 1:8 - 1:4 - 1:2 - 1:1 - 2:1,
and so on up to 32:1. There are a number of different ways in which you can alter the zoom factor,
as described in “Image Viewing Options”.

� Note: When the Zoom window is initially displayed, a low resolution continuous tone image is
shown. When zooming in, from one point onwards (at approx. a 1:8 zoom factor), the high
resolution raster data is shown instead.

� Note: More than one Zoom window can be opened for a particular page, each with its own
zoom factor.
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� Note: When opening pages to preview, the page is initially shown as a low resolution
continuous tone image. When zooming in, if you have the Raster Preview option, the
continuous tone image is replaced with the high resolution raster data allowing for previewing
traps, halftone dots, etc. Only the full version of Apogee PDF RIP for Windows will allow for
high resolution raster data previewing. Other versions of Apogee PDF RIP for Windows can be
upgraded to include the Raster Preview option.

Selecting the ‘Show Separations’ item from the ‘Window’ menu, allows you to toggle individual
separations on or off (see “Viewing Single Color / Composite Planes”), and to check the Ink
Coverage of the selected area (see “Checking Ink Coverage”)

In the bottom left corner, there is a small status bar. When images are being displayed, the status
bar displays the name of the separation which is currently being processed. The status bar also
displays the results when checking image screen angles (see “Checking Screen Angles”). When no
images are being processed, the status bar remains blank.

� Note: Windows 98 & Windows NT Users: At the bottom of the screen, in the right-hand
corner of the status bar, an animated icon indicates that data is being transferred.

The way in which raster data is displayed in the zoom window can be customized through a number
of settings in the Preferences dialog (see “Setting Attributes for the Zoomable Window”). Zoom
windows can also have rulers in user-selectable units of measurement (millimeters, centimeters,
inches, pixels, or picas). For further information, see “Choosing Measurement Units”.
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Raster Preview Pilot Menu Bar

The Menu Bar at the top of the Preview main window gives you access to five menus:

� File

� Edit

� Image

� Window

� Help

Each of these menus contains a list of options which allow you to open and close pages, set image
viewing options and preferences, and abort or approve pages for imaging, as illustrated below:

Connect...

Open...

Close

Approve Page...

Approve Job...

Quit

Cut

Copy

Paste

Delete

Select All

Preferences...

Fit To Window

Full Size

Zoom In

Zoom Out

Rotate

Flip

Show/Hide Rulers

Units

Auto Contrast

New Window

Show/Hide Overview

Show/Hide Separations

Show/Hide Job Info

Tool Palette (for PC)

Help Topics

About Preview Pilot (for PC)

File Edit Image Window Help

Figure 5:  Raster  Preview Pi lo t  Menu Bar  Opt ions
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Floating Tools Palette

Whenever you start Preview, a floating Tools Palette is opened, it can be hidden and shown with
the Window/Tool Palette menu (PC only). This palette contains four tools for examining the image
in the currently active Zoom window, as follows:

Area Select Tool
This tool is provided for use with the “Checking Ink Coverage” feature. When this tool is
selected, a rectangle can be drawn in the active Zoom window by clicking and dragging. If
the Separations window is already open, the ink values for the selected region are updated
immediately; if not, they are recalculated when the Separations window is opened.

Pan Tool
This tool is provided for viewing a page that exceeds the size of the Zoom window. When
this tool is selected, the image in the active Zoom window can be moved around over small
distances within the window. The image is updated when the mouse button is released.
You can also pan an image by dragging the rectangular locator in the Overview window.

Zoom Tool
When this tool is selected, the contents of the active Zoom window can be zoomed in (by
clicking) or zoomed out (by Option-clicking for Macintosh users, or Shift-clicking for
Windows users). Simple clicking zooms around the mouse position, while click-and-drag
selects a zoom region of a user-specified size.

Screen Angle Tool
This tool is provided for checking screen angles in the currently active Zoom window. When
this tool is selected, clicking in the active zoom window and moving the mouse calculates
the distance and angle between the point where the mouse button was pressed and the
current mouse position. Distances are measured in the units specified in the Image menu
(see “Choosing Measurement Units”).
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Preview Options
This section describes the options for opening and previewing pages, and for checking image
details such as individual color planes, ink coverage, and screen angles.

Connecting to the Raster Preview Server / RIP

To connect or reconnect to the Raster Preview Server / RIP, proceed as follows:

� Note: Typically the Raster Preview Server host computer is also the Apogee PDF RIP host
computer.

1 Select 'Connect...’ from the File menu,

The Connect To Server window is automatically opened.

A list of Raster Preview Server host computers is displayed in the scrollbox. Any Raster
Preview Servers which are currently unavailable, or are connected to another user, are grayed
out.

� Note: Remember that when a Preview Pilot connects to a Preview server, they maintain a
1-to-1 connection. This means that as long as that connection is active, no other client
can connect to that server.

2 Select the name of the Raster Preview Server to which you want to connect, and click on the
‘Connect’ button (Mac users), or the ‘OK’ button (PC users).

The Preview main window is displayed, and the Open dialog is automatically presented.

To open a page to preview, follow the steps described below.

Opening Pages to Preview

1 To open a page to preview, proceed as follows:

2 Select 'Open...’ from the File menu.

The Open dialog is displayed. The Open dialog lists all of the jobs that are currently available
on the selected Apogee PDF RIP, together with the number of pages in each job. A checkmark
to the left of a job name indicates that the RIP has finished processing all pages of the job, and
all pages are ready for preview.

� Note: Jobs without a checkmark have only been partially processed by the RIP. This
means that not all pages of the job are yet available for preview.

3 Select the name of the job you want to preview, and click on the ‘Open’ button (Mac users), or
the ‘OK’ button (PC users).
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A numerical list of pages within the job which are available for previewing is displayed.

4 Select the page number that you want to preview, and click on the ‘Open’ button (Mac users),
or the ‘OK’ button (PC users).

The requested page is displayed.

� Note: You can open multiple different pages within a job, but you cannot simultaneously open
and view pages from different jobs.

� Note: When opening pages to preview, the page is initially shown as a low resolution
continuous tone image. When zooming in, if you have the Raster Preview option, the
continuous tone image is replaced with the high resolution raster data allowing for previewing
traps, halftone dots, etc. Only the full version of Apogee PDF RIP for Windows will allow for
high resolution raster data previewing. Other versions of Apogee PDF RIP for Windows can be
upgraded to include the Raster Preview option.
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Opening Multiple Views on a Page

In addition to opening multiple pages, you can also open up multiple windows on the currently
selected page to display detailed views on different areas of the image.

• While your selected page is active, select ‘New Window’ from the Window menu:

Preview opens a new Zoom window for the current page. Each of the Zoom windows you open
can display a different part of the page with a different zoom factor.

� Note: The maximum number of windows that you can have open at any given time depends
largely on your Raster Preview Pilot system’s memory configuration.
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Closing Previewed Pages

To close a single Zoom window (and associated Overview window) proceed as follows:

1 Click the mouse inside the window that you want to close.

This makes the window the active window.

2 Select 'Close' from the File menu.

To close all windows:

� Macintosh users: Hold the ‘Option’ key down while selecting ‘Close’.

� Windows users: Hold the ‘Shift’ key down while selecting ‘Close’.

Image Viewing Options

Preview provides you with several tools for zooming, panning, and resizing images and windows.

Zooming
Point Zoom In: Click on the Zoom tool and then click on a point in the Zoom window to
zoom in on that point in the image. Preview calculates an appropriate zoom factor to fit the
active zoom window on your screen. Each time you click on the Zoom tool, the zoom factor
is halved, until you reach the maximum zoom-in level (32:1).

Area Zoom In: Click on the Zoom tool and then click-and-drag in the Zoom window to
select a rectangular area of your choice. The selected area is then re-scaled to fill the
current window size. The re-scaling is performed to the nearest zoom factor to the power of
2.

Point Zoom Out: Click with the Zoom tool while holding down the ‘Option’ key (Macintosh
users) or ‘Alt’ key (Windows users) to zoom out on the contents of the active Zoom window.

Area Zoom Out: Click on the Zoom tool and then click-and-drag in the Zoom window to
select a rectangular area of your choice while holding down the ‘Option’ key (Macintosh
users) or ‘Alt’ key (Windows users). The current window contents are then re-scaled to fit
into the selected region. The re-scaling is performed to the nearest zoom factor to the
power of 2.

� Note: Each successive operation that you start will interrupt any ongoing operation. This
means that if you start a new operation, such as a zoom in, before an ongoing operation is
completed, then the ongoing operation will be aborted.

Panning
This tool is provided for viewing a page that exceeds the size of the Zoom window. In this
situation, click first on the Panning tool, and then click and hold down the mouse button on
a point in the Zoom window. You can now pan the image by moving the mouse around the
Zoom window. The image is updated when you release the mouse button.

� Note: You can also pan an image by dragging the rectangular locator in the Overview
window.
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Fitting the Image Size to the Screen Size
If the size of a page you are previewing is larger than the size of your display screen, you can resize
the image to fit the screen as follows:

• Select 'Fit To Window’ from the Image menu:

Fit To Window calculates an appropriate zoom factor to make the active zoom window fit on
your screen. Image re-scaling is performed to the nearest zoom factor to the power of 2.

Rotating an Image
You can rotate an image through 0°, 90°, 180°, or 270°, as follows:

1 Select the window which contains the image you want to rotate.

2 Select ‘Rotate’ from the Image menu, and hold down the mouse button while you select the
required rotation factor from the extended options.

Flipping an Image
You can flip an image, either vertically or horizontally, as follows:

1 Select the window which contains the image you want to flip.

2 Select 'Flip’ from the Image menu, and hold down the mouse button while you select either the
‘Vertical’ or ‘Horizontal’ extended option.

Displaying a Full Size Image
To display a full size image, at the zoom factor of 1:1 (i.e. one raster data pixel is displayed using 1
screen pixel), proceed as follows:

• Select 'Full Size’ from the Image menu.

The image in the currently active Zoom window is displayed full size.

Showing / Hiding the Overview Window
Display of the Overview window can be toggled on or off as follows:

• Select either 'Show Overview’ or ‘Hide Overview’ from the Window menu.
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Viewing Single Color / Composite Planes

Selecting to view single color planes or any combination of color planes is done in the Separations
window. Select ‘Show Separations’ from the Window menu.

The Separations window allows you to toggle individual separations on or off.

You can place a checkmark next to any of the color planes to display that color. All combinations of
process and spot colors may be selected.

Checking Ink Coverage

The Separations window also indicates the percentage of ink that is used in any given area of the
currently active Zoom window. This feature is used in conjunction with the Area Select tool.
The Ink coverage contained by the Area Select Tool will be displayed in the Separations window for
each separation. When no area is selected, the Ink coverage from the active zoom window will be
displayed.

When the Area Select tool is selected from the Floating Tool Palette, a rectangle can be
drawn in the active Zoom window by clicking and dragging. The ink coverage for the
selected region is then calculated, and the results are displayed in the Separations window.



Chapter 2: Using Preview 36

The procedure is as follows:

1 Choose the Area Select tool by clicking on the rectangular icon in the Floating Tool Palette.

2 Select an area in the Zoom window by clicking and dragging the mouse:

3 When you are satisfied with the area you have selected, release the mouse button.

The Separations window indicates the percentage of ink used in the selected region of the
Zoom window:

The ink coverage percentage is displayed for each process and spot color plane. This
information is calculated on the basis of the real pixel data, and is accurate to within around
3%. When zoomed in at 1:1, the information is accurate to 1%.

� Note: If the Separations window is already displayed, then it will be updated every time a new
area is selected in the Zoom window. Also, if a particular color separation is deselected in the
Separations window, no Ink Coverage value for that separation will appear.
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Displaying Job Information

You can choose to display a window which provides information on the current job. This feature can
be toggled on or off.

• Select 'Show Job Info’ from the Window menu.

A job information window is displayed, similar to the following:

The job information comprises:

� Document name.

� Creator.

� Job ID.

� User name.

� Channel (RIP input channel).

� Device name.

� Page number.

� Page size, in the customized units of measurement (millimeters, inches, pixels, etc.) See
“Choosing Measurement Units”.

� Page resolution, in dpi.
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� List of separations (process & spot colors)

Checking Screen Angles

You can use Preview to display screen angles in ripped pages, before sending them to the
imagesetter. This function is very useful for avoiding unwanted moiré effects in the final output.

The procedure is as follows:

1 Choose the Screen Angle tool by clicking on the icon in the Floating Tool Palette.

2 Click on a point in the active Zoom window and move the mouse pointer to another point in the
window.

As you move the mouse, Preview automatically calculates the distance and angle between the
point where the mouse button was pressed and the current mouse position. Distances are
measured in the units you have specified (see “Choosing Measurement Units”.)

� Note: You need to select a good pattern to achieve useful results.

The results of these calculations are displayed in the status bar at the bottom left-hand side of
the window (or at the bottom right-hand of the screen for Windows 98 and Windows NT users):

� The first of these two values indicates the screen angle between the two points,
expressed in degrees.

� The second value indicates the distance between the two points, in the user-specified
units.



Chapter 2: Using Preview 39

Redefining Colors

In order to provide an accurate display of color images, Preview must convert the CMYK values of
the ripped separations into RGB values that can be displayed by a computer monitor. Although this
conversion works well for the standard CMYK process colors, this is not always the case where
spot colors are concerned.

However, since each spot color is output on its own separation, Preview allows you to redefine the
color which has been automatically selected to represent the spot color. In this way, you can choose
a color which may be more representative of what will be actually printed on the press.

The procedure for doing this is as follows:

1 Open the Separations window and click on the color indicator of the color you want to redefine.

The color picker is displayed:

The color picker allows you to redefine the RGB values (or CMYK, Pantone, HSL,...) of any
spot colors in the image. You cannot change the values for process colors.

2 Change the RGB values by adjusting the sliders, or by entering values directly into the color
percentage fields.

3 Click on the ‘OK’ button to save your changes.

� Note: Windows 98 & Windows NT Users: Although the appearance is different, the
functionality of the color picker under Windows is basically the same.



Chapter 2: Using Preview 40

Showing / Hiding Rulers

You can display rulers for each of the zoom windows, using any of the standard units of
measurement. This is done by toggling the option in the Image menu between ‘Show Rulers’ and
‘Hide Rulers’.

Rulers are displayed using the units of measurement you have specified (see “Choosing
Measurement Units”.)

� Note: Rulers are absolute. This means that zero is always located at the top left-hand corner of
the page. No redefinition of this ruler zero point is possible.

• Select ‘Show Rulers’ from the Image menu.

Rulers are added to the active Zoom window which is open:

Choosing Measurement Units

• To specify the units of measurement that Preview will use, select ‘Units’ from the Image menu.
You can choose millimeters (mms), centimeters (cms), inches, pixels, or picas:
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Quitting Preview

You can quit Preview at any time as follows:

• From the Preview menu bar, select 'Quit' from the File menu (for Mac users), or select ‘Exit’
(for PC users).

Preferences
Preview provides you with a number of options for customizing the way in which pages are
displayed for viewing. These global settings define the default properties for all windows which are
currently open, as well as all windows which you subsequently open.

For example, you can:

� Set the size of the Overview window

� Set the properties of all zoomable windows

� Set miscellaneous display options, such as image inverting for previewing negative images,
flipping, rotating and raster preview.

� Configure RIP connections that are across TCP/IP network routers.

1 From the Edit menu, select ‘Preferences...’:

The Preferences dialog is displayed, as follows:

2 Make any changes you require to the displayed preference options (as described below), and
click on the ‘OK’ button.
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� Note: All open windows are dynamically updated with the new settings when you make any
changes to your preferences.
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Setting the Size of the Overview Window

You can set the size of the Overview window by clicking on ‘small’ or ‘large’. The Overview window
cannot be rescaled from either of these two settings.

� Note: You can also hide the Overview window as described in “Showing / Hiding the Overview
Window”.

Setting Attributes for the Zoomable Window

By clicking on the Zoomable Window pop-up menu (Mac) or radio button (PC), you can set the
default initial attributes for all pages that are opened. Selecting a new page either creates no Zoom
window, a full color Zoom window, or a Zoom window with only the black separation initially visible.

Your options are as follows:

� None: No Zoom window is opened. When you select a page for viewing, only the Overview
window is displayed. This mode is useful if you want to quickly see a “thumbnail” of a page,
rather than reading in the whole page. This is the fastest way of accessing a page.

� Black Separation: When you select a page for viewing, only the black separation is displayed.
This mode is much faster than Full Color mode.

� Full Color: When you select a page for viewing, all of the color separations are displayed. This
is the default option.

Setting Display Options

Negative Images
This option transposes the solid areas of an image to transparent, and transparent areas to solid,
and is applied to each of the image separations. This option is useful for previewing negative
separations.

For example, suppose an image is made up of 4 separations; cyan, magenta, yellow, and black.
Each separation is actually made up of only 2 types of areas - solid areas (black) and transparent
areas. When you select “Negative Images” (Mac), or “Negative Separations” (PC), Preview
reverses the display of these areas individually on each separation. This means that, on the cyan
plate, all cyan areas are displayed as transparent, and all transparent areas are displayed as cyan.
The same reversal is applied to the magenta, yellow, and black plates.

Enable raster preview
When this option is enabled, you will be able to see the actual high resolution raster data which
allows you to examine the halftone dots, screen angles, traps, etc. If this option is disabled, only a
low resolution continuous tone image of the page will be shown.

Setting Page Orientation Options
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Rotate
This option rotates all Zoom windows and the Overview window using the specified rotation factor
(0°, 90°, 180°, or 270°).

Flip Horizontally
This option “flips” all images 180° along a vertical axis.

Flip Vertically
This option “flips” all images 180° along a horizontal axis.

RIP Connections

The Raster Preview Pilot uses the TCP/IP protocol to connect to and communicate with the Raster
Preview server. Raster Preview servers do not display in the Connect to Server list (see
“Connecting to the Raster Preview Server / RIP” in this chapter) if there is a router between the
Raster Preview Server and the Raster Preview Pilot.

You can add the IP address or host name of the Raster Preview Server / RIP to the RIP
Connections list (Mac), or RIP Server list (PC) to enable communication with the Raster Preview
Server / RIP across a network router. The servers added to this list will be found across routers.

RIP connections can be added to and removed from the list using the Add and Remove buttons.

� Note: It is required that the router is configured to support multicasting.
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Preview Approval Options
When you have finished previewing the pages of a job, you have the following approval options:

� Approve for imaging

� Approve for backup

� Approve for imaging and backup

� Delete

You can choose an approval option for a single page or for an entire job, as described below.

Approving a Single Page

• From the Raster Preview Pilot menu bar, select ‘Approve Page…’ from the File menu:

The Approval dialog is displayed, as follows:

The default settings for the “Image” and “Backup” checkboxes are retrieved from the PPD file’s print
option settings, which were chosen when the job was printed “for Preview”. However, you can
override these settings now by enabling/disabling the checkboxes.
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Approve for Imaging
If you simply want to approve the previewed page, and send it directly to the imagesetter, proceed
as follows:

1 Enable the ‘Image’ checkbox

2 Disable the ‘Backup’ checkbox

3 Click on the ‘OK’ button

Result: Once it has been sent to the imagesetter, this page will no longer be available for
previewing or imaging. If you want to re-image the page at a later date, you must select one of the
options below.

Approve for Backup
If you want to approve the previewed page, and keep it on disk for imaging at a later date, proceed
as follows:

1 Disable the ‘Image’ checkbox

2 Enable the ‘Backup’ checkbox

3 Click on the ‘OK’ button

Result: The page will simply be saved on disk. If you want to re-image this page at a later date, you
can do so using the Agfa Job Backup function. For more information about Agfa Job Backup, refer
to your “Agfa Job Backup User’s Guide”.

Approve for Imaging and Backup
If you want to approve the previewed page, send it to the imagesetter, and keep a backup on disk,
proceed as follows:

1 Enable the ‘Image’ checkbox

2 Enable the ‘Backup’ checkbox

3 Click on the ‘OK’ button

Result: The page will be sent to the imagesetter, and will also be saved on disk. If you want to
re-image this page at a later date, you can do so using the Agfa Job Backup utility. You will not
need to submit it again to the RIP.

Delete
If you do not want to approve the previewed page, proceed as follows:

• Click on the Delete button

Result: The previewed page will be deleted, and will no longer be available for previewing or
imaging (the checkboxes are ignored).  If you want to re-image this page at a later date, you
must submit it once more to the RIP.
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Approving an Entire Job

The procedure for approving all pages in a job is similar to approving a single page as described
above.

1 From the Raster Preview Pilot menu bar, select ‘Approve Job…’ from the File menu:

The Approval dialog is displayed as follows:

Note that in this case, the message changes from ‘Approve Page #’ to ‘Approve Job’.

� Note: Windows 98 & Windows NT Users: This options ‘Current Page’ or ‘All Pages’ can be
selected in the ‘Approve’ dialog window itself.
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Using Help
Preview includes an on-line Help facility which can be accessed from the main menu. You can
access topics either by using the Help Contents, or by Searching for a topic.

� Note: On Macintosh computers, the Help facility is based on Apple Guide which must be
installed on your Macintosh system.
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Preview Keyboard Shortcuts

Macintosh Users Windows Users

�O Open Job /Page to Preview CTRL-O Open Job /Page to Preview

�W Close Window CTRL-W Close Window

�P Approve Page CTRL-P Select Approval Option

option-
�P

Approve Job

�Q Quit Preview CTRL-Q Quit Preview

�F Fit Image To Window CTRL-F Fit Image To Window

�1 Display Full Size image CTRL-1 Display Full Size image

�+ Zoom In CTRL-+ Zoom In

�- Zoom Out CTRL-– Zoom Out

�R Show / Hide Rulers CTRL-R Show / Hide Rulers

�N Open a New Window CTRL-N Open a New Window

�J Show / Hide Job Info CTRL-I Show / Hide Job Info

�Z Undo Action CTRL-S Show / Hide Separations

�X Cut F5 Rotate 0°

�C Copy F6 Rotate 90°

�V Paste F7 Rotate 180°

�A Select All F8 Rotate 270°

�I Show / Hide Separations F9 Flip Horizontal

�K Connect F10 Flip Vertical

CTRL-X Cut

CTRL-C Copy

CTRL-V Paste

Del Delete

CTRL-A Select All
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multiple page preview, 32
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approval modes, 18
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main window, 26

Menu Bar, 28

multiple pages, 32

options, 17

pages, 30

preferences, 41

printing, 15

quitting, 41

selecting a job, 16

server, 13

using, 19

workflow, 15

Preview Pilot

starting, 23

Preview server

starting, 22

printing, 15

Q

quitting Preview, 41

R

redefining colors, 39

requirements

client, 21

Windows NT server, 21

RIP

connecting, 30

ripped job

structure, 16

rotate, 44

rotating an image, 34

rulers, 40

S

screen angle tool, 29

screen angles

checking, 38
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job for Preview, 16
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shortcuts
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keyboard, 49

show job info, 37

show overview, 34

show rulers, 40

single page approval, 45

starting

Preview Pilot, 23

Preview server, 22

system requirements, 21

T

tools

area select, 29

pan, 29

screen angle, 29

zoom, 29

U

using

Help, 48

Preview, 19

V

vertical

flipping, 44

viewing

single/composite planes, 35

W

window

overview, 25, 26

zoom, 25, 26

Windows NT server

requirements, 21

workflow, 15

Z

zoom tool, 29
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